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The WDS 400 Water Detection System 
is a coulometric analyzer designed for
detection of water in solids, using the
combined techniques of thermal analysis
and coulometry.  The detection limit of
the analyzer is in the parts-per-million
(ppm) range.  The sample quantity
required for successful detection depends
on the expected water content in the
material, and may be anywhere from 
2 mg to 2000 mg.

The WDS 400 analyzer offers the 
following special features:

– Drying technique similar to that 
of a drying oven.  Unlike Karl Fischer
titration, this technique uses no toxic
chemicals (which are subject to strict
disposal regulations).  This precludes
problems with the acquisition and 
disposal of special tracing fluids, as well
as any need for wet-chemical fusion 
of the sample material.

– High sensitivity of measurement 
(detection of water content from 15%
down to the ppm range).

– Fast and even heating of the sample
from room temperature to a maximum
of 400°C in the electrically heated oven.

– Programmable heating curve for 
separate detection of different water
components (surface water, capillary
water and water of crystallization)
through fractionated expulsion of water
from the sample.

– Storage of temperature curves for 
multiple analysis routines performed 
on a single sample type (for example,
routine analysis for quality control in
incoming and final inspection).

– Functions for storing and loading 
temperature curves ensure flexibility
when analyzing different types of 
samples.  Development of optimized
temperature curves by analyzing series
of a single sample type.

– Storage and loading of measurements
for later evaluation.

– Printout of measurements for ISO/GLP-
compliant documentation.  Sensor 
current and temperature curve are
included in the documentation.
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Intended Use

– Compensation of measurement results
to take ambient humidity into account
(“tare measurement”).

– Calibration standard (Na2WO4) for 
calibrating the analyzer included in
delivery.

– Optional password protection for 
analysis and evaluation software.

– Easy-to-clean sample scoop made of
nickel.

The WDS 400 analyzer is ideal for 
use as an inspection, measuring and
test instrument in development, quality
control, in-process control and incom-
ing inspection.

Symbols
The following symbols are used in these
instructions:

§ indicates required steps

$ indicates steps 
required only under certain conditions

> describes what happens after you have
performed a certain step

– indicates an item in a list

! indicates a hazard

Note:
The program window illustrations 
in this manual were made using the 
latest program version at the time of
printing. Sartorius reserves the right to
make changes to the program without
notice.

For technical advice on applications: 
Phone: +49.(0)551.308.3160 
Fax: +49.(0)551.308.3495
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The WDS 400 analyzer complies with
the European Council Directives as well
as international regulations and stan-
dards for electrical equipment, electro-
magnetic compatibility, and the stipu-
lated safety requirements.  Improper use
or handling, however, can result in
damage and/or injury.

To prevent damage to the equipment,
read these operating instructions thor-
oughly before using your analyzer.
Keep these instructions in a safe place.

Please observe the following to ensure
safe and reliable operation of your ana-
lyzer:

!Use the analyzer only for determining
the water content of samples.  Any
improper use of the analyzer can
endanger persons and may result in
damage to the analyzer or other materi-
al assets.

!If you use electrical equipment in instal-
lations and under ambient conditions
requiring higher safety standards, you
must comply with the provisions as
specified in the applicable regulations
for installation in your country.

!Do not use this analyzer in a hazardous
area/location; operate it only under the
ambient conditions specified in these
instructions.

– Personnel operating the analyzer must
have certified training in handling
chemicals.  Furthermore, the operator
must have thorough knowledge of the
properties of the sample material being
analyzed.

!The analyzer must be connected to a
power supply (mains) that is equipped
with a protective grounding conductor.
A power supply of 230 V, 50 Hz is
required (see “Connecting the Weighing
Platform to AC Power” in the chapter
entitled “Getting Started”).

– The analyzer comes with a power supply
that has a grounding conductor.

– Use only extension cords that meet the
applicable standards and have a protec-
tive grounding conductor.

– Disconnecting the ground conductor is
prohibited.

– To avoid danger of overload, do not
connect the analyzer to a multiple 
socket.

– Connect only Sartorius accessories and
options, as these are optimally designed
for use with your analyzer.

– Note on installation:
The operator shall be responsible for
any modifications to Sartorius equip-
ment and must check and, if necessary,
correct these modifications.  On request,
Sartorius will provide information on
the minimum operating specifications
(in accordance with the Standards listed
on page 44 for defined immunity to
interference).

– Protect the analyzer from contact with
liquid

– If there is visible damage to the equip-
ment or power cord, turn off the power
and disconnect the equipment from AC
power immediately.  Lock the equip-
ment in a secure place to ensure that 
it cannot be used for the time being.

!Do not insert anything into the ventila-
tion slots or other openings in the hous-
ing.

!If any liquid enters the equipment 
housing, disconnect the analyzer from
power immediately and notify the 
customer service center.

– The paint and the powder coating 
on the housing are chemical-resistant 
to a limited extent only.  Avoid contact
with aggressive chemicals such as acids
or solvents.

!Clean your analyzer according to the
cleaning instructions only (see “Care
and Maintenance”).

!Do not open the equipment housing.

– This device uses nitrogen or dried 
compressed air as carrier gas.

!Nitrogen can supplant the oxygen in 
the air.  This is especially hazardous
when working with nitrogen in closed
areas.  If the oxygen concentration in 
a given area drops below 15%, this will
reduce the ability of persons in that area
to work.  Oxygen concentrations below
11% will quickly result in loss of 
consciousness.

!If a gas cylinder is used for the carrier
gas supply, make sure the cylinder can-
not tilt or fall (see “Getting Started”).
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In case you have any problems with
your analyzer: 

$ contact your local Sartorius office, 
dealer or service center.

Warning: Severe Burns!

– This analyzer is approved for use in
continuous operation.

– To prevent build-up of heat, install the
analyzer in a well-ventilated location
with at least 40 cm (approx. 16 in.)
space on all sides.  The surface on which
the analyzer rests must be heat resistant
up to at least 60°C (140°F) (see “Instal-
lation Instructions” in the chapter 
entitled “Getting Started”).

– Do not place flammable materials on,
under or near the analyzer.

– The tube oven inside the analyzer can
reach temperatures of 400°C (752°F)
and higher.  For this reason, use extreme
care when inserting and removing 
samples.  Use only the forceps supplied
to handle the sample scoop.  The sam-
ple temperature is displayed by the
operating program.

Hazards for persons or equipment
posed by using specific samples:

Fire Explosion

– Do not heat samples beyond the 
melting point.  Evaporation of uncon-
trollable chemical compounds or denat-
uration of the sample due to excessively
high temperatures must be avoided at
all costs.  Otherwise, there is a risk of
contamination of the gas flow system
and damage to the electrolytic cell.
Overheated sample material can adhere
to the sample scoop permanently, in
which case the scoop must be replaced.
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– It is the responsibility of the user 
to have or acquire specific knowledge 
of any alterations that can occur in 
the chemical composition of the sample
material, and of which chemical sub-
stances can evaporate or be emitted
from the sample material, as a result 
of exposure to heat.

Poisoning Caustic burns

!Gases which are toxic and hazardous 
to the health can be released when
working with this analyzer.  For this rea-
son, the exhaust tubing must be con-
nected to a discharge conduit, or must
conduct the exhaust into the open air.

!Never place the following types of 
substance inside the analyzer:

– Flammable or explosive substances
– Substances that contain solvents
– Substances that release flammable or

explosive gases or vapors during the
heating process

When in doubt, perform a risk analysis.
The user shall be liable and responsible
for any damage that arises in connec-
tion with this analyzer.

The emergence of any of the gases 
listed below will restrict the functioning
of the WDS 400.  In this case, the phos-
phorous pentoxide electrolytic cell may
have to be regenerated or replaced.

Gases that react with phosphorous pen-
toxide:

– alkaline gases, such as ammoniacal gas
– chlorous gases

Gases that are dehydrated by phospho-
rous pentoxide:

– alcohols, for example

Gases that can form solid or liquid 
polymerization products:

– for example, unsaturated carbon
hydrides such as acetylenes, alkadienes,
and alkenes (higher than propylene)

Gases that attack platinum:
– hydrogen fluoride



The WDS 400 Water Detection System
consists of the analyzer, a control and
evaluation program, and accessories.

The analyzer contains the heating 
and operating units, the phosphorous
pentoxide electrolytic cell and the serial
data interface for connection to the PC
on which the control and evaluation
program is installed.  The accessories
supplied with the analyzer include,
among other things, the power cord,
cable for PC connection, connectors 
for the inlet and outlet of the carrier gas
(nitrogen or compressed air) and a case
containing additional equipment for
performing analysis (sample scoop, 
forceps, etc.).

Storage and Shipping Conditions
Allowable storage temperature: 
-10°C to +50°C (+14°F to +122°F).

Before putting the equipment into
operation, allow it to acclimate to the
ambient temperature inside the dust
cover to prevent condensation within
the equipment.

Do not expose the analyzer to extreme
temperatures, moisture, shocks, blows
or vibration.

Unpacking the Analyzer
§ After unpacking the equipment, please

check it immediately for any visible
damage.

$ If any sign of damage is visible, 
proceed as directed under “Safety
Inspection” in the chapter entitled 
“Care and Maintenance.”

It is a good idea to save the box and all
parts of the packaging until you have
successfully installed your analyzer.
Only the original packaging provides 
the best protection for shipment.

Before packing your analyzer, unplug 
all connected cables to prevent damage.
Use the plug supplied to close the gas
inlet.

Note:
Always keep the door to the sample
chamber closed; to insert a sample,
open it only briefly.  This prevents mois-
ture from entering the system.

Recycling the Packaging
Sartorius products are packaged to
ensure safe shipment using environ-
mentally friendly materials.  After 
successful installation of the analyzer,
you should return this packaging for
recycling because it is a valuable source
of secondary raw material.

Equipment Supplied
The equipment supplied includes the
components listed below: 

– WDS 400 coulometric analyzer

– Power cord

– Interface cable for connection to the PC
(9-pin D-Sub male connector to 
9-contact D-Sub female connector)

– CD with control and evaluation program

– Exhaust tubing for the WDS 400, 
plastic, 3 m

– Adapter for gas cylinder, 1/8 inch

– Gas connection tubing, extendable,
approx. 2 m

– Regeneration kit

– Accessory Set containing:
5 sample scoops
1 forceps
2 Teflon filters
1 sample spatula
1 fine-bristle brush
1 calibration standard, 20 g

in a 50 ml bottle
Substance: Na2WO4 (sodium tungstate)

The following additional equipment,
not included in delivery, is also required
for operation of the WDS 400 analyzer:

– Weighing instrument for precise deter-
mination of sample weight.

The following table shows the optimum
sample size and required weighing
instrument resolution (accuracy) based
on the expected water content of 
sample substances:

Water Optimum Accuracy of
content sample qty. balance
% mg mg

10 2 0.01

1 20 0.1

0.1 200 1

0.01 2000 10

In general, the relative error of the 
sample quantity should be lower than
0.2 %.  For more information on this
topic, please refer to “Sample Analysis”
the chapter entitled “Operating the
Analyzer.”

– Computer system for control of the
analyzer and evaluation of results:
Windows® NT/2000/XP with at least
one RS-232 interface available.

Windows® NT, Windows® 2000 and Windows® XP
are registered trademarks of Microsoft Inc.

– Carrier gas: 
Nitrogen or argon of quality class 4.0 /
5.0, with adjustable pressure reducer to
at least 1 bar and fine pressure gauge,
or dried air with a dew point of < -70°C.
If connected to an in-house supply, 
add a dust filter (< 5 µm).

!Note: 
When working with compressed 
nitrogen in gas cylinders, make sure to
observe the applicable regulations and
safety instructions (see the chapter enti-
tled “Warning and Safety Information”).

– Recommended tools for putting the
analyzer into operation:
Open-ended wrenches: 30/32, 12/13,
10/11
Ring wrench: 20/22
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Installation Instructions
The analyzer is designed to provide 
reliable results under normal ambient
conditions in the laboratory and in
industry.  The following minimum
requirements on the place of installa-
tion must be met:

– Choose a place of installation with suf-
ficient space to position the weighing
instrument for weighing samples next
to the analyzer.  Thus the place chosen
for installation of the analyzer must
also meet the conditions required for
installation of the weighing instrument
(for details, see the installation and
operating instructions for the particular
weighing instrument).

– Chose a place of installation with 
sufficient space for positioning the PC,
required for control and evaluation of
analysis, near the analyzer.

– The place of installation must permit
the supply of carrier gas (nitrogen,
argon or compressed air) required for
operation.

– The analyzer must be installed at a
location that permits safe discharge of
the carrier gas from the analyzer outlet
(for example, near a discharge conduit).

– Set up the analyzer on a stable, even
surface that is not exposed to excessive
vibrations.

– The analyzer produces heat during
operation.  For this reason, the surface
on which the analyzer rests must be
heat-resistant up to 60°C (140°F).
Make sure to choose a place where
excessive heat cannot build up (allow at
least 40 cm space on each side).  Leave
sufficient space between the analyzer
and materials that are affected by heat.

– Avoid placing the analyzer in close
proximity to a heater or otherwise
exposing it to heat or direct sunlight.

– Protect the analyzer from direct 
exposure drafts that come from open
windows or doors.

– Make sure the place of installation is dry
and free of dust.

– Protect the analyzer from aggressive
chemical vapors.

! If a gas cylinder is used for the carrier
gas supply, make sure the cylinder 
cannot tilt or fall.
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Conditioning the Analyzer
Moisture in the air can condense on the
surface of a cold analyzer whenever it is
brought to a substantially warmer place.
If you transfer the analyzer to a warmer
area, make sure to condition it for
about 2 hours at room temperature,
leaving it unplugged from AC power.
Afterwards, if you keep the analyzer
connected to AC power, the constant
positive difference in temperature
between the inside of the analyzer and
the outside will practically rule out the
effects of moisture condensation.

Setting up the Analyzer
§ Unpack the analyzer and set it up at the

place of installation.

§ Connect the analyzer to the carrier gas
supply (gas cylinder or in-house supply)
and provide for the safe discharge of
the carrier gas that exits the analyzer
(for example, by connecting the exhaust
tubing to a discharge conduit).

§ Connect the serial interface of the ana-
lyzer to the PC.

§ Connect the analyzer to power.

Further details on these topics are pro-
vided in the corresponding sections in
the following pages.

Note:
This equipment has been tested and
found to comply with the limits for a
Class A digital device, pursuant to Part
15 of the FCC rules. These limits are
designed to provide reasonable protec-
tion against harmful interference when
the equipment is operated in a commer-
cial environment. This equipment gen-
erates, uses and can radiate radio fre-
quency energy and, if not installed and
used in accordance with the instruction
manual, may cause harmful interference
to radio communications. Operation of
this equipment in a residential area is
likely to cause harmful interference in
which case the user will be required to
correct the interference at his own
expense. Changes or modifications not
expressly approved by Sartorius AG
could void the user’s authority to 
operate the equipment. 



Pos. Designation

1 Sample chamber (oven)
2 Housing fan for cooling electronic elements
3 RS-232 interface port for connecting the PC 

(9-contact D-Sub  female connector)
4 Gas outlet for connection to the exhaust tubing
5 Gas inlet for connection to the extendable connection

tubing (sealed with cap in this illustration)
6 Power switch
7 Power socket/inlet connector with built-in fuse
8 Left-hand side of analyzer:

Fine adjustment valve for gas flow when oven door is open 
9 Left-hand side of analyzer: 

Fine adjustment valve for gas flow during analysis

Pos. Designation

10 Electrolytic cell with P2O5 moisture sensor
11 Oven fan
12 Teflon filter
13 Gas flow indicator
14 Sensor current indicator (10-stage LED band)
15 Power supply indicator
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Operating Elements and Display
Front view:

– Sample chamber (1).
The sample chamber (oven) is designed
for insertion of the sample scoop.  
The door of the sample chamber has 
a locking device for gas-tight closure.
Always keep the door closed to prevent
moisture from entering the sample
chamber, and open it only briefly when
inserting a sample.

– Power supply indicator (15). 
The green LED is lit when the power
supply to the analyzer is active.

– Sensor current indicator (14).
The electrical current flowing through
the P2O5 moisture sensor is indicated 
(in mA) by the 10-stage LED band.
Each diode represents 10 mA.

– Gas flow indicator (13).
A movable ball indicates the currently
active gas flow in ml/min.  This provides
a reference for adjustment of the gas
flow using the fine adjustment valves
(8) and (9) on the left-hand side of the
analyzer.  Multiply the displayed value
by 100 to arrive at the actual flow rate.

Left-hand side:
– Fine adjustment valves for gas flow

control (8) and (9).
Use these valves to set the flow rate 
of the carrier gas.  The valve labeled
“load” controls the flow of gas when
the oven door is open (counter-flow).
This almost entirely prevents moisture
from entering the sample chamber.  The
valve labeled “measure” controls the
flow of gas when the oven door is
closed (in standby mode and during
analysis).  The gas flow is switched from
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“measure” to “load” automatically when
the oven door is opened and closed.
The active flow rate is shown on the gas
flow indicator (13).

Rear view:
– Power switch (6).

The power switch is used to turn the
analyzer power supply on and off.

– Power socket (7).
This socket is for connection of the
power cable to the power supply
(mains).  The fine-wire fuse is located
directly above this socket.

!Operate the analyzer only with a supply
of 230 V, 50 Hz.

– Gas inlet (5).
The extendable gas connection tubing
for the carrier gas supply (included in
the Accessory Set supplied) is connected
here.  The gas inlet is closed with a spe-
cial cap to keep the inside of the ana-
lyzer clean.  Keep this cap in a safe
place and always use it to seal the gas
inlet when no gas supply is connected 
(for example, for storage and shipping).

– Gas outlet (4).
Connect the exhaust tubing (included in
Accessory Set supplied) to this outlet to
conduct the gas out of the analyzer.  To
avoid the hazard of poisoning, the carri-
er gas should be conducted either into
the open or to a discharge conduit.

– Serial RS-232 interface (3). 
9-contact D-Sub female connector for
the cable that connects the PC to the
analyzer.

– Electrolytic cell with moisture sensor
(10).
If the sensitivity of the sensor decreases,
the sensor must cleaned, re-coated or
replaced.  Any of these tasks can be per-
formed by the user (see “Cleaning and
Replacing the Moisture Sensor” in the
chapter entitled “Care and Mainte-
nance”).

– Teflon filter (12).
Protects the electrolytic cell from 
contamination by particles larger than 
3 µm.  Check the filter regularly and
clean it if necessary (see “Cleaning and
Replacing the Teflon Filter” in the chap-
ter entitled “Care and Maintenance”).

Accessory Set

Pos. Designation

16 Sample scoop
17 Forceps
18 Brush
19 Teflon filters (2 pcs)
20 Sample scoops (5 pcs)
21 Calibration standard: sodium tungstate, 20 g

16
17
18

19

20

21



Connecting the Analyzer to the PC
§ Use the cable supplied to connect the

analyzer to the PC.  The corresponding
9-pin D-Sub female connector (3) 
is located on the back of the analyzer.
Connect the cable to an RS-232 inter-
face on the PC; for example, on COM1.
If the desired port on the PC has a 
25-pin rather than a 9-pin connector,
use an adapter (not included in delivery)
to connect the cable from the analyzer.

Connecting Electronic Peripheral
Devices
Disconnect the analyzer from AC power
before connecting or disconnecting
peripheral devices to or from the PC
(RS-232 interface).

Connecting the Analyzer to AC Power
§ Make sure the power supply specifica-

tions match the requirements (230 V,
50 Hz).

! If the specifications do not match, 
do not put the analyzer into operation.

Use only
– Power cords supplied with the analyzer
– Power cords approved by a certified

electrician
– If you need to connect an extension

cord, use only a cable that has a protec-
tive grounding conductor.

§ Powering a device of protection class 1:
Plug the power cord into an electrical
outlet (mains supply) that is properly
installed with a protective grounding
conductor (protective earth = PE).

Safety Precautions
If you use an electrical outlet that 
does not have a protective grounding
conductor (protective earth), make sure
to have a certified electrician install
equivalent protection according to the
installation requirements valid in your
country.  Make sure the protective
grounding effect is not neutralized 
by use of an extension cord that lacks 
a protective grounding conductor.

Connecting the Gas Supply
§ Connect the carrier gas supply (e.g.,

nitrogen cylinder, quality class 4.0 / 5.0)
to the analyzer.

! If a gas cylinder is used for the carrier
gas supply, make sure the cylinder 
cannot tilt or fall.

– Remove the protective cap from the gas
inlet on the back of the analyzer and
keep it in a safe place for future use.

– Connect the extendable, flexible stain-
less steel gas connector tubing to the
gas inlet and use an open-ended
wrench to tighten the connection.

– To connect a gas cylinder, use
the 1/8” adapter pipe thread supplied.

Note:
Do not use fittings or tubing made of
plastic; otherwise, moisture could pene-
trate the gas lines through diffusion.

– Hand-tighten the union nut on the
stainless steel tubing, and then tighten
it an additional 1/4 turn with an 
open-ended wrench.

Note:
– Use the built-in fine pressure gauge 

and fine adjustment valve to maintain
constant pressure in the gas lines.

– For gas cylinders, use the pressure
reduction valve (up to 1 bar) in 
conjunction with a fine pressure gauge.

– If connected to an in-house supply, 
add a dust filter (< 5 µm).

§ Connect one end of the exhaust tubing
to the exhaust connection supports on
the analyzer, and the other end to 
a discharge conduit or open air outlet.

!Always provide for safe discharge of the
exhaust gas from the analyzer, as the
products of disintegration from certain
sample substances may be toxic.
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Installing the Control and Evaluation Software
§ Shut down all active programs make sure no memory-resident 

programs are running in the background during installation.
§ Re-start Windows® to make sure none of the operating system 

components required for installation are being used by other 
programs.

§ Temporarily deactivate any anti-virus software.
§ Insert the CD in the CD drive.
§ Open the “Start” menu and click on “Run.”
§ Enter “d:\setup.exe” (for “d:” enter the letter used by the drive in

which the installation CD is inserted) on the command line and click
on “OK.”

> The installation routine starts.

§ Continue installation:  click on “Next.”  To stop the installation,
click on “Cancel.”

Note:
The program checks whether it has already been installed.  
If it has, the user is prompted to choose one of three options:
“Modify,” to make changes in an existing installation of the 
program; “Repair,” to correct errors in the earlier installation, 
or “Remove,” to de-install the program.  Before selecting “Modify”
or “Repair,” it is advisable to make a backup copy of the program.

$ Select the desired option and click on “Next” to continue.

§ Continue in accordance with the information and prompts given by
the installation program.



§ Enter the target drive and directory for installation.

$ To change the path name, click on “Change.”  This opens a window
where you can select the desired folder (see next illustration).

Otherwise, click on “Next” to use the default path suggested by the
program.

$ To install the program on a different drive or in a different directory
than the defaults, enter the desired path under “Folder name: “.

§ Confirm the selected installation path:  click on “Next.”
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§ To start the installation procedure, click on “Install.”  To stop instal-
lation, click on “Cancel.”

> The installation routine copies the required data into the target
directory, installs the program, and then reports the successful
installation.

§ Confirm the end of installation:  click on “Finish.”

§ Create a shortcut to the “WDS 400” program as follows:  
Right-click on an empty area of the Desktop 
and select “New > Shortcut” from the shortcut menu.

> This opens the “Create Shortcut” window.

§ Click on the “Browse” button and select the installation path and
file name of the WDS 400 program.
Click on “Next” to confirm the selected path.

§ Enter a name for the shortcut, such as “WDS 400,” and click on
“Finish” to confirm.

> The shortcut to the “WDS 400” program is created.  The Desktop
icon for the program is , representing a water molecule.

§ Re-start the PC and reactivate the anti-virus software.  
To start the “WDS 400” program, double-click on the icon.



Analyzer Functions

The WDS 400 coulometric analyzer combines two field-proven
methods, thermal analysis and coulometry, to create a powerful
technique for detection of trace amounts of water in solids.

The thermoanalytical procedure involves heating a sample at 
a defined temperature curve to distinguish between the different
forms of water bond.  Because water is bound to the sample material
through different physical forces, such as van der Waals forces,
hydrogen bonds, dipole forces and electrostatic interactions, 
it takes different forms of thermal energy to release the water from
the sample.  Thus the controlled application of heat at different
temperatures makes it possible to distinguish between surface
water, capillary water and water of crystallization.

The electrochemical sensor in the WDS 400 operates on the principle
of coulometry, which enables selective and quantitative detection of
the water expelled from the sample.  Coulometry involves measuring
the amount of electricity, or the charge, required to disintegrate
(dissociate) a material through electrolysis.  Faraday’s Law is applied
to compute the initial mass of the disintegrated component from
the electrical charge (i.e., the product of current intensity and time)
produced during disintegration.

With the WDS 400 analyzer, the electrolytic dissolution of the 
water molecules released during heating is caused by the chemical
reaction with phosphorous pentoxide, which takes place in the 
electrolytic cell (sensor).

The diagram on the left illustrates the operating principle of the
electrolytic cell in the WDS 400.  A thin coating of phosphorous
pentoxide (P2O5) is applied between two parallel electrodes using 
a special coating process.

The entire detection technique is illustrated on the next page and
described briefly in the following:

The water expelled from the sample by the application of heat is
taken up by an inert (chemically inactive) carrier gas that is fed into
the oven, and is conducted from the oven to the electrochemical
sensor through a system of tubing.  In the sensor, the gas carrying
the water from the sample flows over a layer of phosphorous pen-
toxide.  Phosphorous pentoxide is extremely hygroscopic, which
means it has a high affinity to water.  Thus the water is completely
absorbed in the phosphorous pentoxide coating.
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The chemical reaction with the phosphorous pentoxide causes the
water molecules to disintegrate; in other words, they are dissociated
into their components parts, hydrogen and oxygen, which are then
conducted out of the system by the carrier gas.  From each elec-
trolyzed water molecule, two electrons contribute to an electrical
charge.  Applying Faraday’s Law, the electrolytic current is linked
directly to the number of water molecules detected and thus to the
mass of the water evaporated from the sample.

The WDS 400 analyzer contains all of the components required 
for this analytical process.  The analyzer performs the analytical
measurements, calculations and evaluations automatically, 
and subsequently provides the user with a quantitative and graphic
representation of the water content in the sample material.  
The measuring range of the WDS 400 extends from approx. 15%
water content to amounts in the ppm range.

A basic measurement sequence is displayed in the program window
shown on the left (for details, see the section entitled “Sample
Analysis”).  An example of a measurement is shown on the basis 
of a defined temperature curve (actual heating curve, indicated 
by the red line).  The area below the analysis current (i.e., the time-
integral of the analysis current) indicates the total water content 
of the sample.  If the analysis current curve has multiple peaks, this
indicates water bonds of varying strengths.  Fractionated drying 
of the sample can be implemented by selecting certain temperature
levels for the different stages of the heating process, to enable 
separate measurement of the different forms of water.

Sample
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Preparation
The following requirements must be met to perform successful
analysis with the WDS 400:

– The equipment must be put into operation and connected to the 
PC in accordance with the instructions.

– The control and evaluation program supplied with the analyzer
must be installed.

These procedures are described in the chapter entitled “Getting
Started.”

Starting the Control and Evaluation Program 
§ Start the PC and double-click on the icon (H2O molecule).

> The “WDS 400” program starts.

§ Enter the password, if one has been assigned, and click on “OK.”
The first time you start the program, no password is assigned.  
(If the program was started unintentionally, click on “Cancel” to
close it down.)

> The main program window opens, showing the “New Analysis” 
window.

The menus, buttons, information and results blocks in the main
window are described briefly in the following:

The toolbar is located below the menu bar.  The “View” menu con-
tains a command for showing and hiding the toolbar.  A checkmark
in the menu (W) indicates the current setting.

Charts mapping the analysis current (“Current/Time”) and oven
temperature (“Temperature/Time”) are shown below the menu bar
and toolbar.

The upper half of this window shows the sensor current over time.
The area below this curve corresponds to the charge used in the
sensor for dissolution of the water, and thus provides a measure for
the water content of the sample.  When the program is not in use
(illustration on the left), this chart is blank.

The lower half of the window shows the temperature in the drying
oven over time (target and actual curves).  The target curve is
defined by the temperature curve file (for example, “Standard.pfl”).
When the program is not in use (illustration on the left), no actual
temperature is displayed.
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Below these two windows is a status bar.  The “View” menu con-
tains a command for showing and hiding the status bar.  A check-
mark next to the menu item (W) indicates the current setting.  The
symbol on the left shows the analyzer status; i.e., indicates whether
it is off, in start-up phase, or ready for use.  The symbol on the right
shows whether the carrier gas is passing through the oven (during
analysis) or through the bypass line.  In the example shown here,
either the analyzer is not connected to the PC, or the analyzer has
not been switched on.  The message “No connection to WDS 400” 
is displayed.

The “Sample,” “Humidity” (moisture) and “Analysis Data” informa-
tion blocks are shown to the right of the analysis charts in the main
window.  These blocks show the target and actual values for the
analysis.  The “Sample” block contains the initial sample weight,
which must be entered before analysis begins.  The “Humidity”
block shows the analysis results, and the “Analysis Data” block
shows data on the current analysis.

The charts and information blocks are described in detail in the 
section entitled “Sample Analysis.”

Menu Bar and Toolbar Buttons
The menu bar contains four menus: “File,” Edit,” “View” and “?”
(Help).

The “File” menu contains commands for the following functions:

– Open a file for a new analysis (“New”)

– Open an existing file (“Open”)

– Store a file (“Save”)

– Store a file under a different name 
(“Save as...”)

– Print a file (“Print...”)

– View the file on screen as it will appear in printed form (“Print pre-
view...”)

– Configure printer settings (“Printer Properties...”)

– Close the program (“Exit”)



The “Edit” menu contains commands for the following functions:

– Begin performing moisture content detection on a sample 
(“Analysis…”)

– Calibrate the analyzer (“Calibration...”)

– Begin what is referred to as a “Tare measurement,” to determine
any effects of moisture not contained in the sample (“Tare...”)

– Perform fractionated evaluation of an existing analysis 
(“Fractioning”)

– Configure program settings; for example, minimum analysis time,
minimum analysis current for shutoff, serial interface settings for
the connection between analyzer and PC, and passwords (“Setup...”)

– Switch the gas flow from the “measure” mode to “bypass” and vice
versa (“Switch gas flow”)

– Define whether compensation values (results of tare measurement)
are considered in analysis (“Use tare offset values”).  When this
function is activated (“W”), the “background” moisture (i.e., residual
moisture detected with no sample in the oven) is subtracted from
each point of measurement.  To activate or deactivate this function
(i.e., toggle it on and off), click on it in the menu.

– Confirm error messages to continue working with the program
(“Error confirmation”)

The “View” menu contains commands for the following functions:

– Show or hide the toolbar (“Toolbar”)

– Show or hide the status bar (“Status bar”)

To show or hide the toolbar or status bar, click on the correspon-
ding menu item.  A checkmark (“W”) in front of the menu item 
indicates that the bar in question is shown.

The “?” (Help) menu contains commands for the following 
functions:

– Open the Help program (“Help”)

– View program information 
(“About WDS 400...”)

Which functions can be activated from the toolbar depends on
whether the analyzer is ready to start an analysis (as shown in the
illustration on the left) or a measurement is in progress.  The “View”
menu contains a command for showing and hiding the toolbar.  
It is advisable, however, to leave the toolbar displayed at all times,
as certain functions can be activated only using toolbar buttons.
The buttons shown during analysis are described in the section 
entitled “Sample Analysis.”
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When the program is started, the toolbar contains the following
buttons:

– Open a file for a new analysis (corresponds to “New” in the “File”
menu)

– Open an existing file (corresponds to “Open” in the “File” menu)

– Store a file (corresponds to “Save” in the “File” menu)

– Begin an analysis (corresponds to “Analysis...” in the “Edit” menu)

– Change the temperature curve.  This function cannot be activated
from any menu.

Define whether compensation values are considered in analysis
(toggle function; corresponds to “Use tare offset values” in the
“Edit” menu).  The graphic display of the button shows whether the
function is active or not.

– Open the Setup program 
(corresponds to “Setup...” in the “Edit” menu)

– Open the Help program 
(corresponds to “Help” in the Help (“?”) menu)

– View information about the program (corresponds to “About WDS
400...” in the Help (“?”) menu)

The buttons shown in the upper right-hand corner of the 
“Current/Time” graph let the user change the display of the time
axis.  Click on “+” or “-” to expand or collapse the time axis.  Click
on “<” or “>” to move the axis to the left or right by five minutes.

The button shown in the upper right-hand corner of the 
“Temperature/Time” graph permits configuration of the maximum
oven temperature that can be set.

To change the maximum temperature, click on .

> The “Temperature” window opens.

Select the maximum temperature that can be set: 250°C or 400°C.
Factory setting:  250°C.

$ To change the setting, click on the ▼ button and select the desired
temperature.  Confirm your selection by clicking on the W (check-
mark) button.



Preparing the Analyzer for Performing Measurements
§ Activate the power supply to the WDS 400 (i.e., switch the “On/Off”

switch to the “On” position).

$ The first time the analyzer is put into operation, enter the serial
number of the analyzer and the port number of the serial interface
on the “Device” page of the “Setup” dialog in the control and 
evaluation program (see “Program Configuration (Setup)” in this
chapter).

$ Before activating the supply of carrier gas to the analyzer 
(i.e., before opening the gas supply valve), start the control and
evaluation program.

Note:
As long as there is no communication between the analyzer and 
the PC, all valves are kept closed to prevent moisture from entering
the gas lines.

> As soon as communication is established between analyzer and PC,
the program begins its start-up phase.  This is indicated in the 
status bar.

§ Open the supply valve (pressure reducer valve) on the carrier gas
supply carefully and use a pressure gauge to set the pre-pressure to
approx. 1 bar.

§ Set the gas flow rates for “oven door open” (“load”) and “perform-
ing analysis” (“measure”) modes.  The “load” and “measure” fine
adjustment valves are located on the left-hand side of the analyzer.
The active flow rate is shown by the indicator on the front of the
analyzer.  (Refer to the diagram of the analyzer under “Overview.”)

Set the flow rates as follows:
– Close the oven door.
– Open the two valves (“load” and “measure”) all the way (turn 

counterclockwise).
– Regulate the “load” valve until the gas flow rate is 600 to 800

ml/min.  This is the counter-flow, activated automatically when the
oven door is open to prevent moisture from entering the chamber.

– Regulate the “load” valve until the gas flow rate is 100 to 200
ml/min.  This is the gas flow rate used to conduct water vapor from
the oven to the moisture sensor.  This flow rate should be main-
tained at a constant level over an entire analysis series, including
tare measurement, calibration and sample analysis.

During operation of the analyzer, the PC program switches auto-
matically between the “load” and “measure” rates when the oven
door is opened and closed.
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Program Configuration (Setup)
§ To run the Setup program, select “Setup...” from the “Edit” menu,

or click on the button.

> The “Enter Setup Password” window opens.  

§ Enter the password, if one has been assigned, and click on “OK.”
The first time you start the program, no password is assigned.

> The  “Setup” dialog opens.
There are five dialog pages:  “Analysis,” “Data,” “Device,” “Connec-
tion” and “User.”  The “Analysis” page is active when you first open
the Setup dialog.  To select a different page, click on the desired
tab.

– Enter or change the data in the input fields as needed (see below).
– To close the Setup dialog and save any changes in the configura-

tion, click on “OK.”
– To close the Setup dialog without saving changes, click on “Cancel.”

§ 1. “Analysis” Page
The minimum analysis time and minimum analysis current are con-
figured here.

$ Minimum analysis time:  This is the shortest period of time during
which the analysis must run before the minimum analysis current is
applied as shutoff parameter.

Recommended setting:  15 minutes, depending on the sample to be
analyzed.  The longer the analysis time, the greater the accuracy of
measurement.  Perform a series of tests to determine the optimum
time for standard analysis of a given sample.

Note:
The temperature curve defined for a particular analysis specifies a
length of time for that analysis.  If the time specified is shorter than
the minimum analysis time configured in the Setup program, analy-
sis is interrupted when the time specified by the temperature curve
has elapsed, even if the minimum analysis current has not been
exceeded.

$ Switch-off current:  After the configured minimum analysis time
has elapsed, the analysis is stopped when the current drops below
this limit.  The lower this limit, the greater the accuracy of measure-
ment.

Recommended setting:  0.500 mA.



§ 2. “Data” Page

– The parameters of the PID regulator for the oven heater are 
configured in the “PID” column.  The values for amplification 
factor, integration range and differential range (“Derivation”) are
configured for optimum regulation.  These parameters may be
changed only by a service technician.

– The “Days to log” parameter is shown in the “Settings” column.
This defines the interval, in number of days, at which a new log file
is created.  These log files are intended for use by service techni-
cians in error diagnosis.

§ 3. “Device” Page

This page contains information on the analyzer connected and the
parameters for communication between analyzer and PC.  Enter the
serial number of the analyzer and the port number of the serial
interface on the PC the first time the analyzer is put into operation.
The baud rate (“Speed”) is set automatically.

The “Type” field shows the analyzer model; this is also entered
automatically.

$ Enter the serial number of your WDS 400 in the “Serial no.” field.
This number can be found on the manufacturer’s ID label on the
back of the analyzer.

$ Enter the data required for connection to the PC in the “Port” and
“Speed” fields.  Click on “OK” to store the data; the interface is
automatically configured for communication with the analyzer.

§ 4. “Correction” Page

The “Standard” fields show the names of the files used for compen-
sation of “background” moisture (see “Tare Measurement”) and for
calibration.  The results of the most recent calibration measurement
are also shown here, including:

– Date:  Date of the most recent calibration

– Cell value:  The amount of charge required for the electrolysis 
of 1 g of water (i.e., the Faraday constant in relation to 1/18 Mol).
The value is 10711 As/g; this is a constant value.

– Water content:  This value is obtained from the calibration standard
(listed on the sample container, for example), and is entered at the
start of calibration.

Example:
The water content of the calibration standard supplied with the
analyzer, sodium tungstate (Na2WO4) is 1.07 %.
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– Cell factor: The percentage of water measured is multiplied by this
factor to calculate the water content of the sample.
This factor is calculated as follows in calibration:  Cell factor =
Nominal value of water content /  actual water content as meas-
ured.

Example: A calibration measurement is performed with sodium
tungstate (Na2WO4) which has a water content of 1.07 %.  The water
content measured is 1.20 %.  This yields a cell factor of 1.07 / 1.20
= 0.89.

!The first time the program is run, the input fields on this dialog
page contain factory default values and the program cannot be
used for performing measurement on samples.  Tare measurement
and calibration measurement must be performed before the analyz-
er is ready to use on samples.  The factory default setting for the
cell factor is 1.0.  This is the value used for the first tare measure-
ment.

§ 5. “User” Page

Passwords for program access are configured on this page:
– Login password:  Enables access to the general user level.
– Setup password:  Enables access to the Setup program
– Master password:  Enables access to both the user level and the

Setup program

When the program is first installed, all input fields on this page are
blank.

Because the master password enables access to both the user level
and the Setup program, it must be configured if either of the other
two passwords are configured.

Recommendation:  Assign all three passwords immediately after
installing the program.

Note:
Passwords are case-sensitive; for example, “xyz” is not the same as
“Xyz”.

$ Entering or changing a password:
– In the desired column (“Login,” “Setup” or “Master”), enter the 

currently valid password under “Old.”  If no password is currently
assigned, leave this field blank.

– Enter the new password under “New,” and again under “Confirm.”
– Click on the “Change” button.  The password is changed, and the

text on the button for closing the Setup program changes from
“OK” to “Close.”

– Change one or both of the other two passwords, if desired.
– Click on “Close” to exit the Setup program, or click on a tab to open

a different dialog page.



Flushing the System

§ The analyzer must be flushed thoroughly with dry gas before it is
used for the first time, and after a long period of disuse, to remove
all traces of moisture or unwanted gases from the system.

– To do this, the program must be in “ready-to-operate” mode 
(the status bar shows “WDS 400 is ready”).  

Note: 
If the status message “WDS 400 is ready” is not displayed, the inlet
and outlet valves are closed to prevent moisture from entering the
analyzer.

Note: 
When the analyzer is in “ready-to-operate” mode, the flow of carrier
gas can be switched from normal operation (gas flows through the
oven and the Teflon filter) to bypass mode (oven and filter are
bypassed) and back again.  To do this, select “Switch gas flow” from
the “Edit” menu or press the “F4” function key.  The switching of
the valves should be audible.  The active mode (normal or bypass) 
is indicated in the status bar of the “WDS 400” program.

– Normal operation:  The wide line at the top, representing the oven,
is colored blue.

– Bypass mode:  The “oven” symbol is black, and the narrow line
passing below this symbol is blue.

– Set the gas flow rate at the “measure” valve to approx. 100 ml/min.

– Observe the level of analysis current.  
If the current exceeds 50 mA, reduce the gas flow until the current
is no higher than 50 mA.

– After a brief pause, reset the gas flow rate to 100 ml/min.

Continuous Operation

The analyzer is approved for use in continuous operation.

§ If the analyzer will not be used for an extended period of time 
(e.g., overnight or on weekends), reduce the gas flow rate.  
To prevent moisture from entering the analyzer when the next
measurement is started, however, and to ensure consistently accu-
rate measurements, do not set a flow rate lower than 50 ml/min.

§ If the analyzer will not be used for a longer period, it can be 
shut off.  In this case, it must be flushed thoroughly (see “Flushing
the System”) before the next analysis, which is relatively 
time-consuming.
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Tare Measurement

To attain the highest possible accuracy it is essential to detect the
presence of any moisture that does not come from the calibration
standard (nor, during analysis, from the sample) before performing
the calibration measurement.  The procedure for this detection is
referred to as “tare measurement.”  This procedure detects “back-
ground” moisture; i.e., residual moisture in the flow of carrier gas,
moisture that enters the system when opening and closing the 
oven door, and moisture on the sample scoop.  Always perform tare
measurement using the same temperature curve definition (for
example, “Standard.pfl”) and under the same conditions as the 
subsequent sample analyses, with the single exception that no 
sample is present on the sample scoop.

Note: 
The tare measurement routine automatically uses the “Tara.pfl” 
file for temperature curve definition.  For this reason, once you 
configure your temperature curve you need to save your definition
under the file name “Tara.pfl” (by selecting “Save as...” from the
“File” menu).  For details, see “Setting the Temperature Curve” in
the section entitled “Sample Analysis.”

Note: 
The heating time configured in the Setup program is not overwritten
when performing tare measurement and calibration measurement.

§ Select “Tare...” from the “Edit” menu.

> The “Tare Assistant” window opens.

§ Click on “Finish” (to cancel tare measurement, click on “Cancel”).

> The “Tare” window opens.

§ Open the oven door, use the forceps supplied to insert the empty
sample scoop (as far as it will go) and close the oven door until you
hear the fastener click into place.  Click on “OK” to begin the tare
measurement.

> The tare measurement is shown in the program window.
The blue line in the upper graph represents the analysis current.  
In the lower graph, the brown line represents the target temperature
curve and the red line shows the actual temperature curve.  The
absolute value for the moisture detected is continuously updated
and displayed in the “Humidity” block, while the actual values for
temperature and analysis current are shown in the “Analysis Data”
block.

Note: 
The minimum analysis time configured in the Setup program is not
overwritten when performing tare measurement and calibration
measurement.



> The following toolbar buttons are available during measurement:

– Stop measurement

– View information about the program (corresponds to “About WDS
400...” in the Help (“?”) menu)

– Open the Help program (corresponds to “Help” in the Help (“?”)
menu)

– Change the temperature curve while the current measurement is
running

> After the minimum analysis time configured in the Setup program
has elapsed, the tare measurement is ended when the current drops
below the limit configured under “Switch-off current.”

§ If you wish to save the tare measurement results in a tare file, click
on “Yes;” otherwise, click on “No.”

> The result of the tare measurement and the name of the tare file are
shown in the Setup program, on the “Correction” dialog page.  The
data stored in this file is applied to all subsequent calibration meas-
urements and sample analyses for which the tare function is active,
until a new tare file is created.

Calibration Measurement

Calibrate the analyzer by performing measurement on a sample with
a known water content.  Calibration measurement is required in the
following instances:

– The first time the analyzer is put into operation
– Following a period of disuse (for example, at the beginning of work

following a weekend or, in some cases, every morning)
– Before performing high-precision analysis of sample material
– After cleaning the filter or moisture sensor
– After re-coating or replacing the moisture sensor
– Any time a sample is evaporated by heating at an excessively high

temperature

Notes:
– Three measurement cycles are recommended for the calibration pro-

cedure.  For the highest demands on accuracy of measurement, per-
form five measurement cycles.

– Any time more than one cycle is performed for calibration, all cycles
are included in the evaluation.
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– Perform all calibration measurements carefully, using a smooth,
even technique.  Use the same technique to be employed during
sample analysis.

– The program uses the “Calib.pfl” file as temperature curve definition
for calibration measurements.  This file is configured for use with
the calibration standard supplied with the analyzer (sodium
tungstate (Na2WO4), water content: 1.07 %).  If you use a different
calibration standard, make sure you modify the “Calib.pfl” file
accordingly.

– The following routine is recommended for use the first time the
analyzer is put into operation:  Flush the system, perform tare
measurement, perform calibration (3 cycles).

– For high accuracy, the current should reach a maximum of approx.
85 mA; i.e., a long, narrow curve is preferable.  Bear in mind that
the analyzer will automatically switch to bypass mode if the analysis
current exceeds 95 mA, to prevent sensor overload.  If this happens,
the measurement results cannot be used for evaluation.

– To use the calibration standard supplied (sodium tungstate), analyze
an initial sample quantity of 20 to 25 mg to obtain a maximum
analysis current of 70 to 90 mA.

– Check the calibration of the analyzer regularly by performing 
analysis on the calibration standard.

§ Select “Calibration...” from the “Edit” menu.

> The “Calibration Assistant” window opens.

§ Enter the number of calibration cycles (for example, 3) 
and click on “Finish” (to stop calibration, click on “Cancel”).

> The window for entering the sample quantity and water content
opens.

§ Place the required sample quantity on an empty sample scoop.
When using the calibration standard supplied with the analyzer,
Na2WO4 with 1.07 % relative moisture, use approx. 20 to 25 mg.

§ Use the forceps supplied to insert the sample scoop in the oven as
far as it will go.  To do this, grasp the tab on the end of the sample
scoop using the forceps.  Close the oven door until you hear the
closure mechanism click into place.

§ Enter the initial sample weight and water content in the respective
input fields.  The water content is indicated on the sample contain-
er; for the calibration standard supplied with the analyzer (Na2WO4),
this is 1.07 %.  Click on “OK” to confirm your input.  



§ To start the calibration measurement, click on “OK.”

> The calibration routine runs automatically until all measurements
have been completed.  The analysis display is continuously updated
during calibration.  The upper graph shows the analysis current over
time, and the lower graph shows the target and actual curves for
the temperature over time.

Note: 
If the measurement begins at a temperature higher than that speci-
fied by the target curve, a warning is displayed on the PC screen.  In
this case, measurement  begins only after you click on “Yes” to con-
firm the warning message.  To stop the measurement, click on “No.”

Note: 
When performing multiple measurement cycles, proceed as follows:
Use a second sample scoop.  While the first measurement is run-
ning, place the second sample scoop on the weighing instrument
and fill it shortly before the first measurement is completed.  At the
end of the first analysis, open the oven door, remove the first sam-
ple scoop and place the second sample scoop in the oven.  Close the
oven door, enter the initial weight in the PC program and start the
next measurement.  While this measurement is running, remove 
the sample residue from the first sample scoop (if necessary, use the
brush supplied to clean the scoop), place the sample scoop on the
weighing instrument and fill is shortly before the second measure-
ment is completed.  At the conclusion of the second measurement,
remove the second sample from the oven and insert the third the
sample.  Enter the initial weight in the PC program and start the
third measurement.  To perform more than three cycles, continue 
as described above.

> At the end of the calibration procedure, the result is displayed in the
program window.

The most important value obtained from the calibration measure-
ment is the cell factor.  In all subsequent sample analyses, the water
content measured is multiplied by this factor to calculate the actual
water content.  In the example shown here, the calibration measure-
ment yielded a value of 1.2 % for the relative water content.  
The nominal value for the calibration standard used is 1.07 %.  
This yields a cell factor (correction factor) of 1.07 / 1.2 = 0.89.

§ To store the calibration measurement, click on “Save.”  (To cancel
the calibration routine without saving the result, click on “Cancel”).

> Once calibration has been completed successfully, enter the name 
of the calibration file, the target value for the water content of the
calibration standard used, and the cell factor on the “Correction”
page of the Setup program.  This calibration data is valid until it is
overwritten by a subsequent calibration measurement.
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Sample Analysis

In order to choose an appropriate sample quantity for testing, 
it is important to know approximately which temperatures are
required for expelling water from the particular sample material.
The temperature curve developed for the actual analysis defines
both the starting temperature and the various levels of temperature
to be attained during analysis, as well as the length of time each
temperature is maintained to expel the different types of water.

The peak level(s) of current produced during analysis depend(s) on
the quantity of water released at a given temperature, which in turn
is dependent on the quantity of sample material tested.  The higher
the peak, the greater the accuracy of measurement.  At the same
time, the analysis current must not exceed 95 mA, as this would
cause the bypass valve to be activated to protect the electrolytic cell
from overload, and the measurement would have to be discarded.
The optimum peak value for the analysis current is 75 to 90 mA.

– The analysis time defined by the temperature curve supercedes the
minimum analysis time configured in the Setup program.

– Leave the gas flow rate unchanged, if possible.  Perform tare 
measurement, calibration measurement and sample analysis using 
a single gas flow rate.

– When analyzing new or unknown substances, perform a series of
test measurements to determine the optimum temperature curve.

– The following is generally applicable:
For powdered substances, use a flatter temperature curve; 
for granulates, use a steeper curve.  For inorganic substances, 
try temperatures from 250 to 400 degrees, while making sure the
substance does not disintegrate (examine the color and smell after
drying).  Use > 20 mg as sample quantity; do not exceed the 
maximum initial weight of 25 to 250 mg.

Setting the Temperature Curve
§ Click on the button (“Load temperature curve”).

There is no menu command for accessing the temperature curve.  
If the toolbar is hidden, select “Toolbar” from the “View” menu to
re-activate the toolbar display.

> The “Temperature profile” window opens.

Temperature curves are stored as files on the PC with the file name
extension “.pfl”.  When you open the temperature curve window,
the most recently used temperature curve file is displayed.  If the PC
has been restarted since the program was last used, the default file
(“Standard.pfl”) is opened.  The file name is shown at the top of the
window, under “File” (in the example shown here, “Standard.pfl”).



The corresponding temperature curve is shown under “Points” and
is also mapped out graphically in the “Temperature/Time” graph in
the lower portion of the main window.

$ Selecting a different temperature curve file:
Click on the “Browse” button (folder symbol) next to the file name
field and select the desired file.

If the time/temperature table of the temperature curve has more
than six time points, only part of the table is displayed; use the
scroll bars at the bottom and on the right-hand side of the table to
view all points.

$ Modifying the temperature curve:
Click on the red “plus” sign in the upper left-hand corner of the
window.  The gray background changes to white.  In the “Tempera-
ture/Time” graph, the mouse cursor is displayed as a cross, and 
a marker below the graph indicates its position along the X-axis
(time).  The coordinates of the mouse cursor are displayed on a gray 
background in a separate field.

– Entering a new temperature level:
Position the mouse at the desired coordinates in the “Temperature/
Time” graph and click.  The coordinates are automatically added to
the table.  Click again to remove the new point (see the illustration
on the left).

Editing the time/temperature table:
Click on the desired row to select it, and then click on the “+” but-
ton.  The selected row is copied, with a time 30 seconds later (see
the illustration on the left).  Double-click on the new row to edit
time and temperature.  The “Time” field accepts only full minutes.
Click on “OK” (to the left of the edited row) to confirm.

– Deleting a temperature level:
Position the mouse on the desired point in the “Temperature/Time”
graph and click.

Deleting a row from the time/temperature table:
Click on the row to select it, and then click on the “-” button.

$ Toggling between “Edit” and “List” mode:
Click on the button with the red “plus” sign.  In “List” mode, the
table is displayed on a gray background; in “Edit” mode, the back-
ground is white.  The mode changes each time you click on the “+”
button (i.e., the table is toggled between modes).

$ Saving the temperature curve under a different name:
Click on the “Drive” button (symbol of a computer drive) next to the
file name field, select the desired path and enter a file name.

§ Confirming changes in the temperature curve:
Click on “OK” at the bottom of the window.  The window closes
and this file is used for subsequent measurements.

30



31

Performing the Analysis

Note:
Store the sample material in close proximity to the place of 
measurement (i.e., the place of installation of the WDS 400 and 
the weighing instrument).  Short distances prevent errors in meas-
urement that result from evaporation of volatile water components,
or from absorption of humidity in hygroscopic samples.

§ Click on (“New file”) or select “New” from the “File” menu.  
This creates a new file for saving measured values.

§ Select a suitable temperature curve (see the previous section).  
In the example shown here, a temperature curve with 4 heating
stages, saved as “Gypsum.pfl,” is used to analyze gypsum (see the
illustration on the left).  The analysis time derived from this 
temperature curve is transferred to the “Analysis time” field in the
“Sample” block in the main window.

§ Specify whether analysis will be performed with or without back-
ground moisture compensation (i.e., whether the value determined
in tare measurement is taken into account; see the “Note” at the
end of this section for details).  If the button is graphically dis-
played as “pressed,” this means tare compensation is activated.
Click on this button to turn the tare compensation function on or
off.

§ Click on (“Start analysis”) or select “Analysis...” from the “Edit”
menu.

> The first window of the “Analysis Assistant” opens.

§ Enter the data specifying the sample here (i.e., designation, 
batch number, source, comment).  The date of analysis is entered
automatically.  The data configured here is transferred to the 
“Sample” block in the main window.

Click on “Next” to confirm your input (to cancel, click on “Cancel”).

> The second “Analysis Assistant” window opens.

§ Place the sample scoop on the weighing pan, tare the weighing
platform and weigh in the sample material.

See “Equipment Supplied” in the chapter entitled “Getting Started”
for a table of estimated sample quantities, listed by water content.
When analyzing samples with unknown water content, conduct a
series of test measurements first to determine the optimum parame-
ters for initial weight and temperature curve.

§ Enter the initial weight in the “Sample weight” field.  The value is
transferred to the “Weight” field in the “Sample” block in the main
window.



Click on “OK” to confirm your input (to cancel, click on “Cancel”).

> A window opens with a prompt to insert the sample into the oven.

§ Use the forceps supplied to insert the sample scoop in the oven.
Close the oven door.

§ To start the measurement, click on “OK.”

Note:
If the measurement begins at a temperature higher than that 
specified by the target curve, a warning is displayed on the PC
screen.  In this case, measurement  begins only after you click on
“Yes” to confirm the warning message.  To stop the measurement,
click on “No.”

During analysis, the toolbar in the main window is changed (see the
section entitled “Tare Measurement”).  
In addition to the buttons for starting the Help program and view-
ing program information, the following two buttons are available:

– Stop measurement

– Change the temperature curve while the current measurement 
is running

The analysis current is displayed and continuously updated both 
in the “Analysis Data” block in the main window and on the front 
of the analyzer.  The indicator on the front of the analyzer is 
a 10-stage LED band.  Each LED represents a current of 10 mA 
(see “General View of the Equipment” in the chapter entitled 
“Getting Started”).

If the sample releases too much water per unit of time, there 
is a hazard that the analysis current might exceed the tolerance 
limits of 95 mA.  In this case, the gas flow should be reduced.  
This reduces the amount of water carried to the moisture sensor
per time unit and causes the analysis current to drop; the 
measurement does not have to be discarded.

If the tolerance limit for the analysis current is exceeded, the system
switches the valves to bypass mode (indicated in the status bar in
the main window).  The measurement is stopped and can no longer
be used for evaluation, because the carrier gas is not flowing
through the oven.  

In this case a warning message is displayed.  The valves remain in
the bypass position until you click on the “OK” button to return the
system to “normal operation” mode.
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Generally, the measurement continues automatically until the
analysis time has elapsed or until the analysis current goes below
the minimum limit configured.

Click on the button to change the temperature manually.  
This can be useful to determine optimum settings when testing
unknown sample materials.  Once the manual temperature modifi-
cation function is deactivated, the analysis procedure continues
with the temperature curve originally configured.

During and after analysis, the analysis current is represented by the
blue line in the upper graph (“Current/Time”), and the target (brown
line) and actual (red line) oven temperatures are shown in the lower
graph (“Temperature/Time”).  A marker under each graph indicates
the current point in time.

The following data concerning the measurement in progress 
is displayed and continuously updated in the three information
blocks to the right of the diagrams:

– “Sample” block:
Shows data describing the sample.  The data is entered by the user
at the start of measurement, in the two “Analysis Assistant” windows.

– “Humidity” (moisture) block:
Shows the relative (“Rel.”) and absolute (“Abs.”) water content of
the sample.  These are the actual results of the coulometric analysis.
The values shown here are calculated and continuously updated
during measurement.  Click on the “Rel.” button to toggle that field
between “ppm” and “%” values.

– “Analysis Data” block:
“Current act:”  Active* analysis current.
“Tare act:”  Offset (tare) value for the active analysis current 
(data from tare measurement).
“Calculated act:”  Calculated net analysis current 
(i.e. present analysis current minus tare value for analysis current).
“Temp act:”  Active oven temperature.

* “active” in this context means “active at the time displayed”

Switch-off current:  Level of analysis current below which the 
measurement will be stopped automatically (value configured in
Setup program).
“Minimum analysis time:” Time limit after which the switch-off 
current (see above) is applied as shutoff parameter (value configured
in Setup program).

Note: 
Each analysis can be performed with or without a tare offset, or
“background” moisture compensation (see “Tare Measurement” in
this chapter).  This parameter must be defined before the beginning
of analysis and cannot be changed later.  When background com-
pensation is active, the offset value is subtracted from each measur-
ing point.  The “Analysis Data” block shows the current actually
measured (“Current act”), the “tare” current (“Tare act”) and the 
difference calculated between the two (“Calculated act”).  When the
background compensation function is not active, the “Current” and
“Calculated” values are identical, and the “Tare” field shows zero.
Negative calculated values are displayed and stored numerically, 
but are not displayed in the graphs.  They are, however, included in
the “Integration” calculation.  At the end of measurement, both
corrected and uncorrected values are stored.



> When analysis is concluded, whether automatically when the 
analysis time runs out or the minimum current is reached, 
or manually interrupted by clicking on , the “Analysis finished”
window opens.

§ To store the measurement, click on “Save.”
To quit without storing, click on “Cancel.”

When you click on “Save,” two files are stored:  one containing
uncorrected data (i.e., without background compensation), with the
file name extension “.ods”, and one containing corrected data, with
the extension “.wds”.  Both files are handled in the same manner
when opened at a later point (see “Loading a Measurement File”
below).  If the measurement was performed without background
compensation, both files have the same contents.

Loading a Measurement File

§ Click on or select “Open” from the “File” menu; browse as 
needed for the required path and select the desired file.

Note: 
The default setting for “File type” is for files with corrected data.
To open a file with uncorrected data, change the “File type” setting
from “WDS 400 files (*.WDS)” to “WDS 400 Realdata files (.ODS).”

> The selected file is opened in the main program window.

In the example shown here, the file created for the analysis 
of gypsum (see “Sample Analysis” above) is opened again for further
processing, such as fractionated evaluation, for example.

Note: 
Loading and evaluating existing files can be performed “off line;”
i.e., the PC does not have to be connected to the analyzer.
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In addition to the commands for opening a new or existing file, 
saving a file, viewing program information, and starting the Help
program, the following buttons are available in the toolbar:

– Blue line:  Display the analysis current in relation to time 
(“Current/Time”) in the upper graph (default setting).

– Green line:  Display the weight of the water contained in the sample
in relation to time (“Weight/Time”) in the upper graph.

– Fractioning function:  Manually define the integration limits for
detection of different forms of water bond.

When the file is loaded, the upper portion of the program window
shows the “Current/Time” graph (see the illustration above).  
The button (blue line) is displayed as “pressed.”

$ If desired, click on the button (green line) to change the 
display from the “Current/Time” graph to the “Weight/Time” graph
(see the illustration on the left).  This button is now activated
(graphically displayed as pressed), while the blue button is displayed
as inactive.  Click on each of these buttons in turn to switch the 
display back and forth between the two diagrams.

The buttons in the upper right-hand corner of the upper graph 
are used to change the “Time” axis (see also “Menu Bar and Toolbar
Buttons” under “Preparation” in this chapter).



Evaluating a Measurement File

The measuring principle of the WDS 400 coulometric analyzer
makes it possible to distinguish the individual water components
that are bound to the sample material through different physical
forces.  The water content of the sample is determined through
integration of the analysis current curve over time.  By selecting
explicit integration limits, the content of a particular peak can be
determined.  This is referred to as “fractionated evaluation,” and 
is performed as follows:

§ Open the file that contains the measurement values from the sample
to be tested (see “Loading a Measurement File”).

> The file is shown in the program window.  The upper graph shows
the analysis current, and the lower graph shows the temperature
(target and actual values) in relation to time.  Click on the (green
line) and (blue line) buttons to switch the display from the
“Current/Time” graph to the “Weight/Time” graph and back again.
For fractionated evaluation, the default display (“Current/Time”) 
is the most practical alternative.

§ Click on (“Fractioning”) or select “Fractioning” from the “Edit”
menu.

> The “Fraction” window opens.

The “Water content” window shows a table with four rows for 
integration of up to 4 user-definable time periods.  To integrate
additional time periods, overwrite the values in an existing row 
in this table.

§ Click on a row in the table (for example, the first line, as shown in
the illustration on the left).

> The line selected is then displayed on a gray background.

§ Define the integration range. 

To do this, set the lower (“t1”) and upper (“t2”) integration limits in
the “Movement” (integration) block using the “<” and “>” buttons.  
If necessary, click on the ▼ button to change the time unit for one
or both integration limits (units available: seconds and minutes).  
For each integration limit, minutes are shown on the left and 
seconds on the right.
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> The result of the integration is displayed immediately in the “Water
content” block.

The water content is shown as a percentage under “Integration.”
Click on the “%” button to toggle the value displayed between 
“percentage” and “ppm.”
The row selected in the table shows the absolute value for the 
water released within the integration range defined by t1 and t2.
The selected integration range is marked by gray shading on the
“Current/Time” or “Weight/Time” graph and on the
“Temperature/Time” graph.

$ Integrating additional time periods:
Click on a row in the table and proceed as described above.  
If there are no empty rows, simply overwrite existing data with 
the desired values to configure additional integration ranges.  
If necessary, write down the existing data first.

$ Ending the fractionated evaluation:  Click on again, or click 
on the “x” in the upper right-hand corner of the “Fraction” window.
When the “Fraction” window is opened again with the same meas-
urement file, the most recently entered data is loaded automatically
and the fractionated evaluation can be continued as described
above.

Printing a Measurement File

Measured data can be printed out on the default printer installed
under Windows.®  The printout generated by the “WDS 400” 
program includes all data required for compliance with GLP stan-
dards, together with the “Current/Time” or “Weight/Time” graph
and the “Temperature/Time graph.  If one or more fractionated
evaluations have been calculated for a particular sample, the 
corresponding results (i.e., from the selected row in the table) are
printed on a separate page.

Windows ® is a registered trademarks of Microsoft Inc.

Note: 
Measured data can be printed at any time.  Simply open the 
measurement file containing the desired data (see “Loading 
a Measurement File” above).

§ Open the “File” menu.

The following options are available here:

– “Print...”

– “Print preview...”

– “Printer Properties...”



$ Select “File > Print” to generate a printout on the default Windows®
printer.

$ Select “File > Print preview...” to view the file as it will be printed.

This window has a toolbar with buttons for increasing the 
on-screen size of the file (“Zoom In,” “Zoom Out”) and activating
the printout.  To close the print preview and return to the main 
program window, click on “Close.”

$ Select “File > Printer Properties...” to open the standard printer 
configuration window.
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Error Possible cause Solution
Software error 7 Data transmission error between Check PC < - > WDS connecting cable

WDS 400 and PC
Software error 9 Data transmission error between Software installation of second device (e.g., mouse) 

WDS 400 and PC must be configured to use the same interface

WDS analyzer not connected Incorrect COM port setting Check the COM port settings
(Status: “no connection”)

Defective connecting cable Check the connecting cable (null modem cable)
Analyzer not switched on Switch on analyzer

Current overload after power-up Analyzer switched off too long Reduce gas flow until the current reaches a level
below 90 mA

Oven door left open Flush analyzer continuously

Current too high during measurement Initial weight too heavy Reduce gas flow until all water has been expelled
Choose a smaller initial quantity for testing

Temperature increased too quickly Lessen the increase gradient of the target curve
(e.g., from 30°C to 200°C in 3 minutes rather  
than in 1 minute)

Excessive fluctuation in oven Unfavorable PID parameters Check the PID parameters; increase
temperature (> 5 °C) if necessary (contact service center)

Water content much lower than expected Defective sensor coating Re-coat sensor
(e.g., during routine measurements) System contaminated In the event of excessive accumulation of impurities

in analyzer and sensor, contact the service center

Strip conductors working loose Sensor too old, or chemically corroded Install new sensor
from sensor Large number of samples with high Avoid frequent overloading of the sensor

water content (> 5 %) analyzed (current > 100 mA)

When switching from oven Oven is leaking Replace the seal on the oven door
to bypass, the gas flow changes Check closure mechanism
significantly (> 50 ml / min)

Cell factor > 1.3 or < 0.8 Sensor coating damaged Re-coat the sensor
Leak in gas system Check for leakage; if necessary, 

send analyzer to service center
System contaminated In the event of excessive accumulation 

of impurities, contact the service center

§ In case of current overload, 
reduce gas flow immediately.

$ If the analyzer has already switched 
to “bypass” mode, leave the gas flow 
at the lower rate for several minutes 
before confirming the error message 
to switch back to normal mode.  
Reduce the gas flow first.
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Service
Regular servicing by a Sartorius 
technician will extend the service life of
your analyzer and ensure its continued
accuracy of measurement.  Sartorius can
offer you a service contract with your
choice of service interval.

The optimum length of the service
interval depends on the operating 
conditions at the place of installation
and on your requirements.

Repairs
Repair work must be performed 
by trained service technicians.  
Any attempt by untrained persons to
perform repairs may lead to hazards 
for the user.

In the event that repairs are to be 
performed, whether at the place of
installation or upon shipment of the
analyzer to the manufacturer, the user
must provide a certificate of safety.  
In this certificate, the user declares that
there are no toxic substances accumu-
lated in or contaminating the analyzer.
This applies in particular when the gas
tubing must be replaced due to sample
evaporation.

Cleaning
!Make sure that no dust or liquid enters

the analyzer housing.

!Do not use any aggressive cleaning
agents (solvents, abrasive cleaning
agents, etc.); clean the analyzer using 
a piece of cloth which has been wet
with a mild detergent (soap) only.

§ Disconnecting the power supply:
Unplug the power cord connector from
the socket on the back of the analyzer
and disconnect the data cable connect-
ing the analyzer to the PC.

§ Check the sample chamber (oven) at
regular intervals for deposits or spills 
of sample material.  Carefully remove
any sample residue/spilled powder using
a brush or a hand-held vacuum cleaner.
Use acetone to remove stubborn
residues.

!When cleaning the sample chamber,
make sure the thermoelement at the
rear of the chamber is not damaged 
or shifted.

§ Check the inner seal of the closure
mechanism on the door; if necessary,
clean the seal by wiping it with a dry
cloth.

§ If more thorough cleaning is necessary,
contact the Sartorius service center.

§ Check the Teflon filter at regular inter-
vals.  For details, see section “Cleaning
and Replacing the Teflon Filter” at the
end of this chapter.

§ If a correction factor of < 0.8 or > 1.3 
is obtained from a calibration measure-
ment that was performed with all due
care, the moisture sensor must be
cleaned or replaced.  For details, see
“Cleaning and Replacing the Moisture
Sensor” at the end of this chapter.

§ Clean the nickel sample scoop included
with the analyzer (in the Accessory Set)
as follows:

Pure nickel is especially resistant to cor-
rosion by alkaline and neutral solutions.
Due to its high melting point (1453 °C),
organic substances that adhere to a
nickel vessel (such as resins or plastic
fusions) can be removed through
annealing.  The resulting discoloration
of the vessel does not affect its utility
for subsequent analyses.  Because nickel
will dissolve in acids over time, do not
use concentrated acids for cleaning.

– Use a brush to remove powdered and
granulated sample material.

– Use a solvent (acetone, ethanol or
methanol) to remove organic material
that adheres to the sample scoop.
Residues that cannot be removed using
solvent can be burned off by annealing.

– Use water or an alkaline solution to
remove inorganic residues; do not soak
the scoop in an acidic solution for more
than a very brief period.

Safety Inspection
If there is any indication that safe 
operation of the device is no longer
warranted: 

§ Disconnect the power supply: 
Unplug the power cord from the wall
socket (mains).

> Lock the equipment in a secure place 
to ensure that it cannot be used for the
time being.

Safe operation of the equipment is no
longer ensured when:

– there is visible damage to the device or
power cord

– the analyzer no longer functions 
properly

– the equipment has been stored for a 
relatively long period under unfavorable
conditions

– the equipment has been subjected to
rough handling during shipment.

In this case, notify your nearest 
Sartorius Service Center.  Maintenance
and repair work may be performed only
by service technicians who are author-
ized by Sartorius and who:

– have access to the required service and
maintenance manuals, and

– have attended the relevant service train-
ing courses.

Recycling
Sartorius products are packaged to
ensure safe shipment using environ-
mentally friendly materials.  After suc-
cessful installation of the analyzer, you
should return this packaging for recy-
cling because it is a valuable source of
secondary raw material.

When submitting the analyzer for 
disposal, the user must provide the 
disposal technician with a certificate 
of safety.
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Cleaning and Replacing the Teflon Filter

The Teflon filter protects the moisture sensor from particles > 3 µm.
Check the filter regularly for impurities and clean as needed.

Proceed as follows to check and, if necessary, clean the filter:

§ Open the filter retainer on the back of the analyzer.

§ Remove the Teflon filter.

§ Check the filter (visual check).

$ If the filter is contaminated (indicated by discoloration or noticeable
odor), it must be replaced.

$ If the filter was contaminated, clean the filter housing with acetone
or naphtha.

$ When replacing the filter, make sure the new filter is pressed firmly
into both O-rings for proper sealing.

§ Close the filter retainer carefully.

§ When closing the filter housing, make sure to clean the outer O-ring
thoroughly and apply a lubricant.

Cleaning and Replacing the Moisture Sensor

The moisture sensor steadily loses sensitivity through sustained use.
This is caused, for example, by impurities accumulated in the sensor
which deactivate the coating, as a result of which only part of the
water in the carrier gas is electrolyzed.  In this case, a lower propor-
tion of water is detected than that actually contained in the sample.
The correction factor (cell factor) is initially > 1.0.  If a cell factor of
> 1.3 is measured, check the sensor and replace it if necessary.  The
same applies for a cell factor of < 0.8.  In this case, a greater pro-
portion of water is detected than that actually contained in the
sample.  If the calibration measurement was performed with all due
care (i.e., the proportion of water not originating from the sample is
equal to the tare measurement value), the apparent detection of
excessively high water content may be caused by leakage current in
the moisture sensor.



Always perform the calibration measurement with care.  
If a correction factor of < 0.8 or > 1.3 is calculated in several 
consecutive calibration measurements, check the moisture sensor
for impurities and replace if necessary.

Proceed as follows to check and, if necessary, replace the sensor:

§ Loosen the fastening screws in the holding device on the back 
of the analyzer until the holding device can be pulled out of the
electrolytic cell.

!Use extreme caution when handling the sensor holding device, 
as the ceramic sensor is fragile and easily damaged or broken.

§ Removing the ceramic sensor from the holding device:
Remove both Phillips head screws.  The two springs between 
the ceramic sensor and holding device cushion the contact between
the electrodes on the small ceramic plate and the connections inside
the analyzer.

§ Cleaning the moisture sensor (ceramic plate):
Rinse the sensor under running water; use a soft-bristled tooth-
brush to remove stubborn deposits, if necessary.

!Make sure the strip conductors are not loosened during cleaning.
Otherwise, the sensor must be replaced.

§ Dry the sensor.

§ Re-coat the sensor:

– Make a solution of 1 part 85% orthophosphoric acid (H3PO4) and 
9 parts acetone.

!Warning:
Orthophosphoric acid is caustic.  Acetone is highly volatile.
For this reason, always wear protective gloves, glasses and lab coat
when mixing this solution.
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§ Soak a lint-free paper towel in this solution and apply an even 
coating to the ceramic plate.  Coat both the front and back of the
sensor.

§ Perform the steps described above in the opposite order to re-install
the moisture sensor as follows:
Position the springs in the holding device and affix the ceramic
plate, allowing for spring suspension, using the Phillips head screws.
Install the holding device in the analyzer, aligning the pin on the
back of the analyzer with the bore hole on the holding device.
Install the screws to affix the holding device to the analyzer.  
The electrodes on the ceramic plate are pressed against the contacts
in the device by the springs; this closes the electrical circuit.

§ Allow at least 60 minutes drying time, under constant gas flow,
after re-coating the sensor.  The power supply of the sensor 
is automatically cut off in the event of current overload.



Specifications 

Power supply: 230 V ± 10 %
Frequency: 50 to 60 Hz
Power consumption: Standby mode: 100 W

Full capacity: 400 W
Fuse: 4 A flink 
Operating temperature: From room temperature 

to 400°C (752°F)
Detection limit: 1 µg water
Repeatability: < 2 %
Display range: ppm - 99.99%

(can be toggled between % and ppm)
Analysis time: 2 min. ... 10 h
Allowable ambient 
operating temperature: +10° C to + 35° C (+50° F to 95° F)
Dimensions: Depth: 500 mm

Width: 500 mm 
Height: 180 mm 

Weight: 20 kg
Max. sample volume: Approx.. 3.5 cm3

Carrier gas: Nitrogen, argon, air
Gas throughput during 
operation: 100-200 ml / min
Gas pre-pressure: Max. 1 bar

CE Conformity

The WDS 400 coulometric analyzer meets the tolerance limits 
set forth in the following standards:

EN 50081 (Limitation of emissions)
EN 50082 (Defined immunity to interference)
EN 61010 (Safety)

This equipment is suitable for installation in residential and 
commercial areas and in small businesses.  If installed in an
industrial area, the equipment may be subject to interference.
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